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HDL Coder Product Description

Generate VHDL® and Verilog® code for FPGA and ASIC designs

HDL Coder™ generates portable, synthesizable VHDL and Verilog code
from MATLAB® functions, Simulink® models, and Stateflow® charts. The
generated HDL code can be used for FPGA programming or ASIC prototyping
and design.

HDL Coder provides a workflow advisor that automates the programming

of Xilinx® and Altera® FPGAs. You can control HDL architecture and
implementation, highlight critical paths, and generate hardware resource
utilization estimates. HDL Coder provides traceability between your Simulink
model and the generated Verilog and VHDL code, enabling code verification
for high-integrity applications adhering to DO-254 and other standards.

Key Features

® Target-independent, synthesizable VHDL and Verilog code

e Code generation support for MATLAB functions, System objects and
Simulink blocks

e Mealy and Moore finite-state machines and control logic implementations
using Stateflow

* Workflow advisor for programming Xilinx and Altera application boards
® Resource sharing and retiming for area-speed tradeoffs
¢ Code-to-model and model-to-code traceability for DO-254

® Legacy code integration
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Prepare Simulink Model For HDL Code Generation

To prepare your Simulink model for code generation:

® Use checkhdl to check that blocks in your model are supported for HDL
code generation.

You can save time by creating your model using blocks from the
hdlsupported library, which you generate using hd11lib. However, not

all available combinations of supported blocks, block implementations,
block properties, and HDL optimizations are supported for code generation.
checkhdl can find many code generation incompatibilities, but you may
need to modify your model later, to generate code that meets your hardware
requirements.

¢ [f you want to synthesize your generated HDL code, convert your model to
fixed point.

To learn how to use Fixed-Point Designer™ to convert your floating-point
model to fixed-point, see “Convert Floating-Point Model to Fixed Point”.

You can synthesize some floating-point constructs if your synthesis tool and
hardware support it. To learn more, see “FPGA Floating-Point Libraries”.

¢ Run hdlsetup to configure the solver for HDL code generation.

1-3
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Tool Setup

In this section...

“C/C++ Compiler Setup” on page 1-4

“Synthesis Tool Path Setup” on page 1-4

“HDL Simulator Setup” on page 1-6

“Xilinx System Generator Setup” on page 1-7

“Altera DSP Builder Setup” on page 1-8

“Xilinx FPGA Floating-Point Library Setup” on page 1-8

C/C++ Compiler Setup

HDL Coder requires a C/C++ compiler in order to compile the test bench
for faster simulation.

For a list of supported compilers, see at
http://www.mathworks.com/support/compilers/current_release/.

Note The LCC compiler is not supported in the current
release. Please use one of the other compilers in the list at
http://www.mathworks.com/support/compilers/current_release/.

Synthesis Tool Path Setup

® “hdlsetuptoolpath command” on page 1-4

* “Add Synthesis Tool for Current HDL Workflow Advisor Session” on page
1-6

e “Check Your Synthesis Tool Setup” on page 1-6

hdlsetuptoolpath command

To use HDL Coder with one of the supported third-party FPGA synthesis
tools, you must add the tool to your system path using the hdlsetuptoolpath


http://www.mathworks.com/support/compilers/current_release/
http://www.mathworks.com/support/compilers/current_release/

Tool Setup

command before opening the HDL Workflow Advisor. If you already have
the HDL Workflow Advisor open, see “Add Synthesis Tool for Current HDL
Workflow Advisor Session” on page 1-6.

The syntax of hdlsetuptoolpath is:

hdlsetuptoolpath ('ToolName', TOOLNAME, 'ToolPath', TOOLPATH)

The input name-value pairs are:

Name Value Description
'ToolName' 'Xilinx ISE' or Specifies the synthesis
'Altera Quartus II' | tool name.
'ToolPath' 'full_path_to_executgbSpecifies the full path
to the synthesis tool
executable.

For example, the following command sets the synthesis tool path to point to
an installed Xilinx ISE 13.1 executable.

hdlsetuptoolpath('ToolName', 'Xilinx ISE',
‘ToolPath', 'C:\Xilinx\13.1\ISE_DS\ISE\bin\nt64\ise.exe');

If you have an icon for the synthesis tool on your Windows® desktop, to find
the tool path:

1 Right-click the icon and select Properties.

2 Click the Shortcut tab.

Tip hdlsetuptoolpath changes the system path and system environment
variables for the current MATLAB session only. To execute hdlsetuptoolpath
automatically when MATLAB starts, add hdlsetuptoolpath to your
startup.m script.

1-5
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Add Synthesis Tool for Current HDL Workflow Advisor Session
Simulink to HDL Workflow

1 At the MATLAB command line, use the “hdlsetuptoolpath command” on
page 1-4 to add the synthesis tool.

2 In the HDL Workflow Advisor, in the Set Target > Set Target Device
and Synthesis Tool step, to the right of Synthesis tool, click Refresh.

The synthesis tool is now available.

MATLAB to HDL Workflow

1 At the MATLAB command line, use the “hdlsetuptoolpath command” on
page 1-4 to add the synthesis tool.

2 In the HDL Workflow Advisor, in the Select Code Generation Target
step, to the right of Synthesis tool, click Refresh list.

The synthesis tool is now available.

Check Your Synthesis Tool Setup

To check your Xilinx ISE synthesis tool setup in MATLAB, try launching
the tool with the following command:

lise

To check your Altera Quartus synthesis tool setup in MATLAB, try launching
the tool with the following command:

lquartus

HDL Simulator Setup

To set up ModelSim®, Questa®, or Incisive® for HDL simulation, or for
cosimulation with HDL Verifier™, see “HDL Simulator Startup”.

Add Simulation Tool for Current HDL Workflow Advisor Session
MATLAB to HDL Workflow

1 Set up your simulation tool.
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2 In the HDL Workflow Advisor, in the HDL Verification > Verify with
HDL Test Bench task, click Refresh list.

The simulation tool is now available.

Xilinx System Generator Setup

To generate ModelSim simulation scripts for a design containing Xilinx
System Generator blocks, you must:
® Have compiled Xilinx simulation libraries.

¢ Specify the path to your compiled libraries.

Required Libraries
You must have the following compiled Xilinx simulation libraries for your

EDA simulator and target language to generate ModelSim simulation scripts:
® unisim

® simprim

e xilinxcorelib

Refer to the Xilinx documentation for compx1ib to learn how to compile these
libraries.

Specify Path to Required Libraries

Specify the path to your compiled Xilinx simulation libraries by setting the
XilinxSimulatorLibPath parameter for your model.

For example, you can use hdlset param to set XilinxSimulatorLibPath:

libpath = '/apps/Xilinx_ISE/XilinxISE-13.4/Linux/ISE_DS/ISE/vhdl/
mti_se/6.6a/1lin64/xilinxcorelib’;
hdlset_param (bdroot, 'XilinxSimulatorLibPath', libpath);
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Altera DSP Builder Setup

To generate code for a design containing both Altera DSP Builder and
Simulink blocks, you must open MATLAB with Altera DSP Builder. Refer to
the Altera DSP Builder documentation for details.

Xilinx FPGA Floating-Point Library Setup

To map your design to a Xilinx floating-point library, you must:

Use Xilinx LogiCORE IP Floating-Point Operator v5.0.

Have the compiled xilinxcorelib simulation library for your EDA
simulator and target language.

Refer to the Xilinx compx1lib documentation to learn how to compile this
library.

Specify the path to your compiled Xilinx simulation libraries by setting the
XilinxSimulatorLibPath parameter for your DUT.

For example, you can use hdlset param to set XilinxSimulatorLibPath

myDUT = gcb;

libpath = '/apps/Xilinx_ISE/XilinxISE-13.4/Linux/ISE_DS/ISE/vhdl/
mti_se/6.6a/1in64/xilinxcorelib’;

hdlset_param (myDUT, 'XilinxSimulatorLibPath', libpath);
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Supported Third-Party Tools and Hardware

In this section...

“Third-Party Synthesis Tools” on page 1-9
“FPGA-in-the-Loop Hardware” on page 1-9

“Simulink® Real-Time™ FPGA I/0 Hardware” on page 1-10
“FPGA Turnkey Hardware” on page 1-10

Third-Party Synthesis Tools

The HDL Workflow Advisor is tested with the following third-party FPGA
synthesis tools:

e Xilinx ISE 14.6
e Altera Quartus II 13.0 SP1

¢ Xilinx ISE 10.1 is supported only for compatibility with Speedgoat FPGA
target devices.

Speedgoat 10301, 10303, and 10311 FPGA 10 boards, which use Xilinx
Virtex-II FPGAs, are tested with Xilinx ISE version 10.1. Before you
select one of these Speedgoat devices in the HDL Workflow Advisor, make
sure that you have installed Xilinx ISE 10.1. See “Generate Simulink
Real-Time™ Interface for Speedgoat Boards” for more information.

For FPGA-in-the-Loop or Customization for USRP® Device using the HDL
Workflow Advisor, a supported synthesis tool must be installed, and the
synthesis tool executable must be on the system path.

FPGA-in-the-Loop Hardware

The FPGAs supported for FPGA-in-the-loop simulation with HDL Verifier are
listed in the HDL Verifier documentation.

You can also add custom FPGA boards using the FPGA Board Manager. See
“FPGA Board Customization” for details.

1-9
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Simulink Real-Time FPGA 1/0 Hardware

The FPGA 1/0 boards supported for use with the Simulink Real-Time FPGA
10 workflow are listed in the Simulink Real-Time documentation.

FPGA Turnkey Hardware
The following hardware is supported for the FPGA Turnkey workflow:

e Altera Arria II GX FPGA development kit

e Altera Cyclone ITII FPGA development kit

e Altera Cyclone IV GX FPGA development kit

e Altera DE2-115 development and education board
e XUP Atlys Spartan-6 development board

¢ Xilinx Spartan-3A DSP 1800A development board
¢ Xilinx Spartan-6 SP605 development board

¢ Xilinx Virtex-4 ML401 development board

¢ Xilinx Virtex-4 ML402 development board

¢ Xilinx Virtex-5 ML506 development board

¢ Xilinx Virtex-6 ML605 development board

For FPGA development boards that have more than one FPGA device, only
one such device can be used with FPGA Turnkey.

Supported FPGA Device Families for Board Customization

You can also add custom FPGA boards using the FPGA Board Manager. HDL
Coder supports the following FPGA device families for board customization;
that is, when you create your own board definition file. See “FPGA Board
Customization”.



Supported Third-Party Tools and Hardware

Device Family

Xilinx

Kintex7

Spartan-3A DSP

Spartan3

Spartan3A and Spartan3AN

Spartan3E

Spartan6

Virtex4

Virtex5

Virtex6

Virtex7

Altera

Cyclone IIT

Cyclone IV

Arria IT

Stratix IV

Stratix V

1-11
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VHDL and Verilog Language Support
The generated HDL code complies with the following standards:

e VHDL-1993 (IEEE® 1076-1993) or later
® Verilog-2001 (IEEE 1364-2001) or later

1-12
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e “HDL Code Generation from a MATLAB Algorithm” on page 2-2
e “HDL Code Generation from a Simulink Model” on page 2-16
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HDL Code Generation from a MATLAB Algorithm

In this section...

“About the Algorithm in This Example” on page 2-2
“Copying Files Locally” on page 2-4

“Checking Your Synthesis Tool Setup” on page 2-4
“Testing the Original MATLAB Algorithm” on page 2-5
“Setting Up an HDL Coder Project” on page 2-6

“Creating Fixed-Point Versions of the Algorithm and Test Bench” on page
2-8

“Generating HDL Code” on page 2-12

About the Algorithm in This Example

For the purpose of this example, you generate and synthesize HDL code for
a MATLAB algorithm that implements a simple filter. However, you can
use HDL Coder to generate HDL code from MATLAB algorithms for many
applications.

This tutorial uses these files:
® mlhdlc_sfir.m — Simple filter function from which you generate HDL

code.

® mlhdlc_sfir_tb.m — Test bench that the HDL Coder project uses to
exercise the filter using a representative input range.

mlhdlc_sfir Function Code
The following code provides the complete mlhdlc_sfir function definition.

s#codegen
function [y_out, delayed_xout] = mlhdlc_sfir(x_in, h_in1, h_in2, h_in3, h_in4)
% Symmetric FIR Filter

persistent ud1 ud2 ud3 ud4 ud5 ud6é ud7 ud8;
if isempty(ud1)
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udli = 0; ud2 = 0; ud3 = 0; ud4 = 0; uds5 = 0; udé = 0; ud7 = 0; ud8 = 0;
end

al = udl + ud8; a2 = ud2 + ud7;
a3 = ud3 + ud6; a4 = ud4 + ud5;

mi = h_in1 * at1; m2 = h_in2 * a2;
m3 = h_in3 * a3; m4 = h_in4 * a4;

a5 = ml + m2; a6 = m3 + m4;

% filtered output

y_out = a5 + a6;

% delayout input signal
delayed_xout = ud8;

%

s update the delay line

ud8 = ud7;
ud7 = ud6;
udé = ud5;
ud5 = ud4;
ud4 = ud3;
ud3 = ud2;
ud2 = udtl;

ud1 = x_in;
end

mlhdlc_sfir_tb.m Test Bench

The mlhdlc_sfir_tb test bench creates an input signal and calls the
mlhdlc_sfir filter, passing in the input data.

clear all;

% input signal with noise
X_in = cos(2.*pi.*(0:0.001:2).*(1+(0:0.001:2).*75)).";

% filter coefficients
h1 = -0.1339; h2 = -0.0838; h3 = 0.2026; h4 = 0.4064;
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len = length(x_in);
y_out = zeros(1,len);
x_out = zeros(1,len);

for ii=1:len
data = x_in(ii);
% call to the design 'mlhdlc_sfir' that is targeted for hardware
[y_out(ii), x_out(ii)] = mlhdlc_sfir(data, h1, h2, h3, h4);

end

figure('Name', [mfilename, ' plot']);
subplot(2,1,1); plot(1:len,x_in);
subplot(2,1,2); plot(1:len,y_out);

Copying Files Locally

Before you begin generating code, set up a working folder and copy the
tutorial files to this folder.

1 Start MATLAB.
2 Create a folder named filter_sfir, for example:

mkdir filter_sfir

The folder must not be within the MATLAB directory structure. You must
be able to write to this folder.

3 Copy the tutorial files, mlhdlc_sfir.m and mlhdlc_sfir_tb.m, to this
folder.

Checking Your Synthesis Tool Setup

Before using HDL Coder to synthesize HDL code, you must set up your
synthesis tool path.

To check your Xilinx ISE synthesis tool setup, try launching the tool with
the following command.:

lise
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To check your Altera Quartus synthesis tool setup, try launching the tool
with the following command:

lquartus

If the tool does not open, or opens the wrong version, see “Synthesis Tool
Path Setup” on page 1-4.

Testing the Original MATLAB Algorithm

Before generating HDL code for this MATLAB algorithm, simulate your
MATLAB design to verify that it runs, and to provide a baseline for
comparison with the generated HDL code.

1 Make the filter_ sfir folder your working folder, for example:

cd filter_sfir

2 Run the test bench. At the MATLAB command line, enter:

mlhdlc_sfir_tb

The test bench runs and plots the input signal and the filtered output.
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Setting Up an HDL Coder Project

1 On the Apps tab, on the far right of the Apps section, click the arrow ¥.

2 Under Code Generation, click HDL Coder.



HDL Code Generation from a MATLAB® Algorithm

3 Enter mydesign for the project name.

HDL Coder creates the project, mydesign.prj, in the local working folder,
and opens the project in the right side of the MATLAB workspace.

HDOL Code Generation

(2| mydesign.prj v i G-

MATLAE Function

I

Specify the top-level MATLABE design function (Design Under Test).

Add only the file that you would call directly from MATLAE. Do not add
files that are called by this function.

Add MATLAB function

MATLAE Test BEench

I

Specify the top-level MATLAB test script or function that calls the
MATLAE design functicn.

Add only the file that you would call directly from MATLAB. Do not add
files that are called by this test file.

Add files

Specify your design function and test bench above, then use the
Workflow Advisor to generate code.

| s Workflow Advisor

4 Under MATLAB Function, click Add MATLAB function.

2-7
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5 In the Add Files dialog box, select mnlhdlc_sfir.m and click Open.
HDL Coder adds the file to the project.
6 Under MATLAB Test Bench, click Add MATLAB test bench.
7 In the Add Files dialog box, select mlhdlc_sfir_tb.m and click Open.
HDL Coder adds the test bench file to the project.
You are now ready to convert the code from floating-point to fixed-point.
Creating Fixed-Point Versions of the Algorithm and
Test Bench

1 In the project, at the bottom of the pane, click the Workflow Advisor
button to open the HDL Coder Workflow Advisor.
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4\ HDL Code Generation

] Define Input Types

Fixed-Point Conversion

HDL Code Generation

HDL Verification

Verify with HDL Test Bench
Verify with Cosimulation
Verify with FPGA-in-the-Loop
= Synthesis and Analysis

Create Project
Run Logic Synthesis

Run Place and Route

E=N NoR =)

HDL Advisor helps you generate synthesizable HDL code from your fixed-point MATLAB design. It also helps you convert your
floating-point MATLAB design to fiked-point based on your selections.

Fixed-point conversion: | Convert to fixed-point at build time

Build folder: :PrOJectfoIder v:

2 Select the Define Input Types task and click Run.

The coder simulates the algorithm and test bench, and automatically
defines input types.

3 On the left, select the Fixed-Point Conversion task. The Fixed-Point
Conversion tool opens in the right pane.

2-9
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4\ HDL Code Generation

E-_] HDL Workflow Advisor

; 0 Define Input Types

__| Fixed-Point Conversion

7 HDL Code Generation

E} |:| HDL Verification

. I Verify with HDL Test Bench
{5 Verify with Cosimulation

¢ I Verify with FPGA-in-the-Loop
=} |:| Synthesis and Analysis

w-{ Create Project

{5 Run Logic Synthesis

- Run Place and Route

@ Propose fraction lengths.
™ Propose word lengths

L %)

Function: = mlhdlc_sfir 'IZ

E=N NoR xR

Run Simulation  Compute Derived ) Advanced VERIFICATION  HELR
- R - Default word length: | 14 - - -
DATA COLLECTION NAVIGATION TYPE PROPOSAL
To compute proposed fixed-point types for variables, use Run Simulation, Compute Derived Ranges, or both. x
1 B R e R R R R R R R R R R R e R R R R R R R R R R R R R R R R R R R R R LR R R AR R LRI R LRI R RIEREREY Il
2 % MATLAB design: Symmetric FIR Filter
3%
4 & Introduction:
5% 3
6 % We can reduce the complexity of the FIR filcer by leveraging its symmecry|.
7% ilcer implies, coefficient hD = coefficient
8 % n this case, the number of B
S & multipliers can be approximately The key is to add the
10 ¥ two data values that need to be multiplied with the same coefficient
11 £ prior to performing the multiplication.
1z %
13 % Ke 1 patter s example:
14 £ (1) states g the persistent variables
15 % (2) in as parameters
16 %
17 %
13
19 % Copyright 2011 The MathWorks, Inc.
20
N -
“atiahles | Function Replacements
Variable Type Sim Min Sim Max Static Min  Static Max ~ Whole Nu... Proposed Type
4 o
h_inl double Ma
h_in2 double Mo L
h_in3 double Mo 1
h_in4 double Mo
w_in double Ma
Pl
delayed_cout dauble Mo
w_out double MNa
Pl
udl double Ma
ud? dauble Mo

At the top left, click Run Simulation.

After the simulation, each input, output, and persistent variable has a

Sim Min, Sim Max, and Proposed Type in the table.

When proposing fraction lengths for floating-point data types, the
coder uses the Default word length. In this tutorial, the Default
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word length is 14. The advisor provides a default Safety Margin for

Simulation Min/Max of 4%. The advisor adjusts the range of the data

by this safety factor. For example, a value of 4 specifies that you want a
range of at least 4 percent larger.

In this example, we use only the simulation ranges to infer fixed-point
types. Compute Derived Ranges gives you the option of using static
range analysis. To learn more about options in the fixed-point conversion
workflow, see “Automated Fixed-Point Conversion”.

At the top, in the Verification section, click Validate Types.

The coder validates the build with the proposed fixed-point types and
generates a fixed-point design.

At the top, in the Verification section, click the down-arrow for Test
Numerics and select Log inputs and outputs for comparison plots.
Click the top part of the Test Numerics button.

The coder simulates the fixed-point design with the original test bench
compares the output to the original floating-point design output.

Click the down-arrow to the right of the Verification OQutput tab and
select Type Validation Output. Click mlhdlc_sfir_fixpt to see the
fixed-point MATLAB code for the mlhdlc_sfir function.

s#codegen
function [y_out,delayed_xout] = mlhdlc_sfir_fixpt(x_in,h_in1,h_in2,h_in3,h_in4)

fm = fimath('RoundingMethod', 'Floor', 'OverflowAction', 'Wrap', 'ProductMode’,
'FullPrecision', 'MaxProductWordLength', 128, 'SumMode', 'FullPrecision',
'MaxSumWordLength', 128);

% Symmetric FIR Filter

% declare and initialize the delay registers

persistent ud1 ud2 ud3 ud4 ud5 ud6 ud7 ud8

if isempty( udl )

udl = fi(0, 1, 14, 12, fm);

ud2 = fi(0, 1, 14, 12, fm);
ud3 = fi(0, 1, 14, 12, fm);
ud4 = fi(0, 1, 14, 12, fm);
uds5 = fi(0, 1, 14, 12, fm);
udé = fi(0, 1, 14, 12, fm);

2-11
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ud7 = fi(0, 1, 14, 12, fm);
uds = fi(0, 1, 14, 12, fm);

end
% access the previous value of states/registers

al = fi(ud1 + ud8, 1, 14, 11, fm);
a2 = fi(ud2 + ud7, 1, 14, 11, fm);
a3 = fi(ud3 + ud6, 1, 14, 11, fm);
a4 = fi(ud4 + ud5, 1, 14, 11, fm);
% multiplier chain

mi = fi(h_int*at, 1, 14, 14, fm);
m2 = fi(h_in2*a2, 1, 14, 15, fm);
m3 = fi(h_in3*a3, 1, 14, 14, fm);
m4 = fi(h_in4*a4, 1, 14, 13, fm);

% adder chain

a5 = fi(m1 + m2, 1, 14, 14, fm);

a6 = fi(m3 + m4, 1, 14, 12, fm);

% filtered output

y out = fi(ab + a6, 1, 14, 12, fm);

% delayout input signal

delayed_xout = fi(ud8, 1, 14, 12, fm);
% update the delay line

ud8 = fi(ud7, 1, 14, 12, fm);

ud7 = fi(udé, 1, 14, 12, fm);
udé = fi(ud5, 1, 14, 12, fm);
ud5 = fi(ud4, 1, 14, 12, fm);
ud4 = fi(ud3, 1, 14, 12, fm);
ud3 = fi(ud2, 1, 14, 12, fm);
ud2 = fi(udt, 1, 14, 12, fm);
udi = fi(x_in, 1, 14, 12, fm);
end

e Click the View report link.

You can explore the fixed-point code further in the Code Generation
Report.

Generating HDL Code

1 In the HDL Workflow Advisor left pane, select HDL Code Generation
and click Run to generate HDL code with the default options.
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The message window has a links to the generated HDL code and the
resource report. Click the links to view the code and resource report.

Tip You can use the Target, Coding Style, Clocks and Ports,
Optimizations, Advanced, and Script Options tabs to set code
generation options. To learn about the options, click the ? button.

In the HDL Workflow Advisor left pane, select HDL Verification > Verify
with HDL Test Bench.

Enable Generate HDL test bench and disable Skip this step. Enable
Simulate generated HDL test bench and select a simulation tool. Click
Run.

The task generates an HDL test bench, then simulates the fixed-point
design using the selected simulation tool, and generates a compilation
report and a simulation report.
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4\ HOL Code Generation

=@ HDL Workflow Advisor
] Define Input Types
a Fixed-Point Conversion
: 0 HDL Code Generation
E‘Q HDL Verification

a Verify with Cosimulation

B gy Synthesis and Analysis
'J Create Project
[ Run Logic Synthesis
i Run Place and Route

@ Verify with HDL Test Bench Generate HOL test bench

-, Verify with FPGA-in-the-Loop

Verify the HDL code with test vectors from the test bench using the specified simulation tool.

Output Settings | Test Bench Options

HDL Test Bench Generation Settings

HDL Test Bench Simulation Settings
Simulate generated HDL test bench

Simulation tool: | ModelSim = |

[ Skip this Step B R

### Begin TestBench generation.

444 Collecting data...
#4## Begin HDL test bench file generation with logged samples
##4 Generating test bench: mlhdlc sfir FixPt th.vhd

### Creating stimulus vectors...
##
### Generating Compilation Report mlhdlc sfir FixPt wsim log compile.txt
### Generating Simulation Report mlhdlec sfir FixPt vsim log sim.txt

### Simulation succeasful.

### Elapsed Time: 188.9228 sec(s)

e

Simulating the design 'mlhdlec sfir FixPt' using 'ModelSim'.

B

4 Click Synthesis and Analysis and disable Skip this step.
a Select Create Project.

b On the right, select a Synthesis tool from the list and click Run.

This task creates a synthesis project for the HDL code. HDL Coder uses
this project in the next task to synthesize the design.

5 Select and run Run Logic Synthesis.

This task:

¢ Launches the synthesis tool in the background.
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® Opens the synthesis project created in the previous task, compiles HDL
code, synthesizes the design, and emits netlists and related files.

® Generates a synthesis report.
6 Select and run Place and Route.

This task:
¢ Launches the synthesis tool in the background.

®* Runs a Place and Route process that takes the circuit description
produced by the previous mapping process, and emits a circuit
description suitable for programming an FPGA.

¢ Emits pre- and post-routing timing information for use in critical path
analysis and back annotation of your source model.

* Displays results.
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HDL Code Generation from a Simulink Model

In this section...

“Before You Generate Code” on page 2-16

“Overview of Exercises” on page 2-17

“The sfir_fixed Model” on page 2-17

“Generate Code Using the HDL Workflow Advisor” on page 2-20
“Generate HDL Code Using the Command Line” on page 2-29

“Generate HDL Code Using the Configuration Parameters Dialog Box”
on page 2-38

“Simulating and Verifying Generated HDL Code” on page 2-49

Before You Generate Code

Before you generate HDL code from your own models, you should do the
following:

® Before generating code, use the hdlsetup utility (described in “Initializing
Model Parameters with hdlsetup” on page 2-30) to set up your model for
HDL code generation quickly and consistently.

e Use the hd1lib utility to create a library of blocks that are currently
supported for HDL code generation, as described in “Create a Supported
Blocks Library”. By constructing models with blocks from this library,
your models will be HDL compatible.

The set of supported blocks will change in future releases, so you should
rebuild your supported blocks library each time you install a new version
of this product.

¢ Use the Run Compatibility Checker option (described in “Selecting
and Checking a Subsystem for HDL Compatibility” on page 2-44) to check
HDL compatibility of your model or DUT and generate an HDL Code
Generation Check Report.

Alternatively, you can invoke the checkhdl function (see checkhdl) to run
the compatibility checker.
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Overview of Exercises

The coder supports HDL code generation in your choice of environments:
¢ The MATLAB Command Window supports code generation using the
makehdl, makehdltb, and other functions.

® The Simulink GUI (the Configuration Parameters dialog box and/or Model
Explorer) provides an integrated view of the model simulation parameters
and HDL code generation parameters and functions.

The hands-on exercises in this chapter introduce you to the mechanics of
generating and simulating HDL code, using the same model to generate code
in both environments. In a series of steps, you will

® Configure a simple model for code generation.

® Generate VHDL code from a subsystem of the model.

¢ Generate a VHDL test bench and scripts for the Mentor Graphics®
ModelSim simulator to drive a simulation of the model.

® Compile and execute the model and test bench code in the simulator.
® Generate and simulate Verilog code from the same model.

® Check a model for compatibility with the coder.

The sfir fixed Model

These exercises use the sfir_fixed model as a source for HDL code
generation. The model simulates a symmetric finite impulse response (FIR)
filter algorithm, implemented with fixed-point arithmetic.

The blocks in this example model support HDL code generation, and the
model parameters have been configured for HDL code generation. To learn
more about preparing your model for code generation, see “Prepare Simulink
Model For HDL Code Generation” on page 1-3.

The following figure shows the top level of the model.
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o002 —» Converld —mo——— s in
From Data Type Conversion
Workspace
y _out ' [ |
01335 P h_in
v _out
Constant
-0.0833 # h_In2
Constant1
0.2026 P h_In3
delayed x_out b I
Constant?
delayed_x scope_out
0.4064 p h_Ind
Constantd

symm etric_fir

This model uses a division of labor that is helpful in HDL design:

® The symmetric_fir subsystem, which implements the filter algorithm, is
the device under test (DUT). An HDL entity will be generated, tested, and
eventually synthesized from this subsystem.

¢ The top-level model components that drive the subsystem work as a test
bench.

The top-level model generates 16-bit fixed-point input signals for the
symmetric_fir subsystem. The Signal From Workspace block generates a
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test input (stimulus) signal for the filter. The four Constant blocks provide
filter coefficients.

The Scope blocks are used in simulation only. They are virtual blocks, and
do not generate HDL code.

The following figure shows the symmetric_fir subsystem.

(2

delayed_xout
1 1 1 1
W R - - M —-
sipclé EniD| - siclf Enid| < s Enl0| < sfed@ EniD| <
uds ud7 ud& ud5
sild_EniD 1 il ST 1 =i Enid 1 fecid_EniD 9 ficiS_Enid
1 ¥ - - > - d > - L
%in z = T z
ud1 ud2 ud3 ud4
I r % *
& * + a4
=07 _Enid s 7_Enid
P =33 En20
: sioedd_EniD *
=503 En20 » fin4 mé
si16_En1d x
=531 En20  § oy
2 h_in3 m3 a| T "
l=faq_Erz0
[
+ +
y_out_pre
=35 _En20
v_out

The fixed-point data types propagate through the subsystem. Inputs inherit
the data types of the signals presented to them. Where required, internal
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2-20

rules of the blocks determine the output data type, given the input data types
and the operation performed (for example, the Product blocks).

The filter outputs a fixed-point result at the y_out port, and also replicates its
input (after passing it through several delay stages) at the delayed x_out
port.

In the exercises that follow, you generate VHDL code that implements the
symmetric_fir subsystem as an entity. You then generate a test bench
from the top-level model. The test bench drives the generated entity, for
the required number of clock steps, with stimulus data generated from the
Signal From Workspace block.

Generate Code Using the HDL Workflow Advisor

This example shows how to generate HDL code from a Simulink model using
the HDL Workflow Advisor.

The model you use in this example, sfir_fixed, is already prepared for code
generation.

This example uses the Xilinx ISE synthesis tool, and assumes your synthesis
tool path is set up. You can also follow this example using Altera Quartus II.

Create Working Folder and Copy Model

1 Start MATLAB.
2 Create a folder named sI_hdlcoder_work. For example:

mkdir C:\work\sl_hdlcoder_work

You will use s1_hdIlcoder _work to store a local copy of the example model
and to store folders and code generated by the coder. The location of the
folder does not matter, except that it should not be within the MATLAB
folder tree.

3 Make the sI_hdlcoder_work folder your working folder. For example:

cd C:\work\sl_hdlcoder_work
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4 Open the sfir_fixed model.

sfir_fixed

5 Save a copy of sfir_fixed in your s1_hdIcoder_work folder.

Generate Code Using the HDL Workflow Advisor

1 Right-click the symmetric_fir subsystem and select HDL Code > HDL
Workflow Advisor.

2 In the Set Target > Set Target Device and Synthesis Tool step, for

Synthesis tool, select Xilinx ISE and click Run This Task.

L HDL Warkflow Sdwvisor - sfir_fized symmetric_fir
File Edit Run Settings Help

Find: v Q5

4 33 HOL WorkFlow Advisor
4 [gg 1. Set Target
0 ~1.1. Set Target Device and Synthesis Tool
4 I3 2. Prepare Model For HDL Code Generation
] 2.1. Check Global Settings
=] ~2.2. Check Algebraic Loops
-] ~2.3. Check Block Compatibility
| ~2.4. Check Sample Times
4 |} 3. HOL Code Generation
> _] 3.1, Set Code Generation Options
| ~3.2, Generate RTL Cade and Testbench
- I8 4. FPGA Synthesis and Analysis

1.1. Set Target Device and Synthesis Tool
Analysis (*~Triggers Update Diagram)
Set Target Device and Synthesis Tool For HOL cade generation

Input Parameters

Target workflow: |GEI‘IEH[ ASICIFPGA

Target platform:

Launch Board Manager

Synthesis tool: |Xilinx ISE

Farnily: | Wirkesxd

v| Device: |xc4vsx35

Package: |fF668

'| Speed: |-10

Project folder:  hdl_prj

Set Target Library (For Aoating-point synthesis support)

Run This Task

result: (@ Passed

Passed Set Target Dewice and Synthesis Tool

Browse. ..

Help

Apphy

m
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3 Right-click Prepare Model For HDL Code Generation and select Run
All. The HDL Workflow Advisor checks the model for code generation

compatibility.
L2 HDL Workflow Advisor - sfir_fixed fsyrmmetric_fir E@
File | Edit PRun Settings Help
Find: v a5
2.4. Check Sample Times
4 |33 HOL WorkFlow advisor Analysis (4T e )
nalysis (“Triggers Update Diagram,
4 _6 1. Set Target B & B ¥
#1.1, Set Target Dievice and Synthasis Tool Check model For glabal sample time settings
4 [gg 2. Prepare Modsl For HOL Code Generation Input Parameters
o 2.1, Check Global Settings Ignore warnings
o ~2.2. Check algebraic Loops
2.3, Chedk Block Compatibilit —
@ P ¥ Run This Task
G 2.4, Check Sample Times
a G s
] 31‘HDL Code Generation r— o -
» I 3.1, Set Code Generation Options
N =] ~3.2, Generate RTL Cads and Testbench Passed Running Check Sample Times passed
» I 4. FPGA Synthesis and Analysis
Help Apphy

4 In the HDL Code Generation > Set Code Generation Options > Set
Basic Options step, select the following options, then click Apply:

¢ For Language, select Verilog.
* Enable Generate traceability report.

¢ Enable Generate resource utilization report.
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1) HDL Warkflow Advisar - sfir_ficedfsymmetric_fir
File | Edit Run Settings Help

Find: - Q5

4 |5 HOL wWorkflow Advisor
4 g 1. Set Target
0 “1.1, Set Target Device and Synthesis Tool
4 _a 2. Prepare Model For HDL Code Generation
O 2.1, Check Global Settings
O ~2.2, Check aAlgebraic Loops
O 2.3, Check Block Compatibility
0 .4, Check Sample Times
4 IZ} 3, HOL Code Generation
4 h] 3.1, Set Code Generation Options
(-] 3.1.1, Set Basic Options
=] 3.1.2. Set advanced Options
| 3.1.3. Set Testbench Options
| 3.2, Generate RTL Code and Testbench
4 |33 4. FPGA Synthesis and Analysis
L] 4.1, Create Project
4 I3 4.2, Perform Synthesis and PR
=] 4.2.1. Perform Logic Synthesis
| 4.2.2. Perform Mapping
| 4.2.3. Perform Place and Route
-] 4.3, Annotate Model with Synthesis Result

3.1.1. Set Basic Options
Target

Generate HOL Fary | sfir_fixed/symmetric_Ffir

Language: |Ver\|ug

Falder: hdl_prihdlsrc

Code generation report

V| Generate traceability report

V| Generate resource utilization repart
Zenerake optimization report

Generate model Web view

Help Apply

5 View the options available in the Optimization and Coding style tabs.
You can use these options to modify the implementation and format of
the generated code.
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1) HDL Warkflow Advisar - sfir_ficedfsymmetric_fir
File Edit Run Settings Help

Find: - Q5

4 |5 HOL wWorkflow Advisor
4 g 1. Set Target
o “1.1, Set Target Device and Synthesis Tool
_a 2. Prepare Model For HDL Code Generation
O 2.1, Check Global Settings
Q ~2.2, Check aAlgebraic Loops
o 2.3, Check Block Compatibility
o .4, Check Sample Times
I 3. HOL Code Generation
4 u.] 3.1, Set Code Generation Options
[ 3.1.1, Set Basic Options
| 3.1.2. Set Advanced Options
| 3.1.3. Set Testbench Options
| 3.2, Generate RTL Code and Testbench
175 4. FPGA Synthesis and Analysis
L] 4.1, Create Project
4 I3 4.2, Perform Synthesis and PR
=] 4.2.1. Perform Logic Synthesis
| 4.2.2. Perform Mapping
| 4.2.3. Perform Place and Route
-] 4.3, Annotate Model with Synthesis Result

N

N

S

3.1.2. Advanced Options

Clock settings

Reset type: Asynchronous - | Reset asserted level: lActlve—hlgh
Clock input part: k. Clack enable input port:  clk_enable
Reset input port: reset

Clock inputs: lS\ngIa

Cwversampling Factor: 1

Additional settings

General Forts Optimization Coding style

Balance delays
[ Hierarchical distributed pipelining

ptimize timing controller

[ Minimize clock enables

RAM mapping threshald (hits): 256
Max oversampling: Inf
IMax computation latency: 1
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1) HOL Workflow: Advisar - sfir_fixed fsyrmmetric_fir

File Edit Run Settings Help

Find: - Q5

4 |5 HOL wWorkflow Advisor

4 g 1. Set Target

o “1.1, Set Target Device and Synthesis Tool
_a 2. Prepare Model For HDL Code Generation

O 2.1, Check Global Settings

O ~2.2, Check aAlgebraic Loops

O 2.3, Check Block Compatibility

o .4, Check Sample Times

N

4 IZ} 3, HOL Code Generation
4 u] 3.1, Set Code Generation Options
[ 3.1.1, Set Basic Options
| 3.1.2. Set Advanced Options
| 3.1.3. Set Testbench Options
| 3.2, Generate RTL Code and Testbench
4

175 4. FPGA Synthesis and Analysis
L] 4.1, Create Project
4 I3 4.2, Perform Synthesis and PR
=] 4.2.1. Perform Logic Synthesis
| 4.2.2. Perform Mapping
| 4.2.3. Perform Place and Route
-] 4.3, Annotate Model with Synthesis Result

3.1.2. Advanced Options
Clock settings

Reset type: Asynchronous - | Reset asserted level: lActlve—hlgh

Clock input part: k. Clack enable input port:  clk_enable

Reset input port: reset Clock inputs: lS\ngIa

Cwversampling Factor: 1

Additional settings

|GEnEra| | Ports I Optimization Coding style

D Represent constant values by aggregates
[ Use "tising_edge" for registers
[ Loop unroling
Use Verilog “timescale directives
[¥] Tnline YHOL configuration

oncatenate bype safe zeros

mit time/date stamp in header

HOL coding standard: Mone -

|:| Scalarize vector ports

[T Minimize intermediate signals

Include requirements in block comments
[ 1nline MATLAE Function block code

[ Generate parameterized HOL code From masked subsystem

RAM frchitecture:

RAM with clack enable hd

6 Right-click the HDL Code Generation > Generate RTL Code and
Testbench step, and select Run to Selected Task.
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L2 HDL Workflow Advisor - sfir_fixed fsyrmmetric_fir E@
File Edit PRun Settings Help
Find: v a5

3.2. Generate RTL Code and Testbench
4 |33 HOL WorkFlow advisor

Analysis (“Triggers Update Diagram
4 [gg 1. 5et Target ysis {~Trigg B aram)

@ ~1.1. Set Target Device and Synthesis Tool Generate RTL cods and testhench For the selected subsystem
4 [gg 2. Prepare Modsl For HOL Code Generation Input Parameters
0 2.1, Check Global Settings V| Generate RTL code

o ~2.2. Check algebraic Loops

o 2.3, Check Block Campatibility ) ) ) )
o ~2.4, Check Sample Times Generate cosimulation model {requires HOL Yerifier)

Generate RTL testbench

4 g 3. HDL Code Generation Cosimulation model For use with | Mentor Graphics MadelSim
4 58 3.1, Set Code Generation Options

o 3.1.1. Set Basic Optians Generate validation model

o 3.1.2. Set Advanced Options Generate FPEA top level wrapper
o 3.1.3. Set Testbench Options
O 3,2, Generate RTL Code and Testbench Run This Task

- I3 4. FPGA Synthesis and Analysis

Result: @@ Passed
i Generating HDL for 'sfir_fiwe dfsymmetric_fir'

i Starting HDL check

m

i Begin VHDL Code Generation for 'sfir_fived'

i Working on sfir_fizedfsymmetric_fir as hdl_prihdlsretsfir_fiwedisymmetric_fir vhd
#H Generared HIML report gymmetric_fir_report.hml

# HDL checlk for 'sfir_fiwed' complete with 0 errors, 0 warnings, and 0 messages.

Help Apphy

The code generation report, which includes the resource utilization and
traceability reports, opens automatically. The resource utilization report
shows the hardware resources your design implementation is using. The
traceability report enables you to navigate between your model and the
generated code.
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Code Generation Repaort

Back Forward

Contents

Surnmary

Clock Summary

Resource Utilization Report
High-level Resource Report
Target-specific Report

Traceability Report

Generated Source Files
symmetric_fir.w

Referenced Models

=5 [ECR 3

HDL Code Generation Report Summary for sfir_fixed

Summary

Model sfir_fixed
Model version 170
HOL Coder version 3.3
HOL code generated on 2013-07-07 00:58:29
HOL code generated for syrametric fir
Target Language Varilog
Target Directaory hdl_prjshdlsre

Non-default model properties

Backannaotation
HOLSubsystem
ResourceReport
TargetDirectory
TargetLanguage

Traceability

on
sfir_fixed/symmetric_fir
an

hdl_prishdlsre

Varilog

an

Non-default block properties

Ma blocks found with non-default properties.

b

Perform FPGA Synthesis and Analysis

1 In the FPGA Synthesis and Analysis > Perform Synthesis and
P/R > Perform Place and Route task, unselect Skip this task and click
Apply.

2 Right-click Annotate Model with Synthesis Result and select Run to

Selected Task.
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1) HDL Warkflow Advisar - sfir_ficedfsymmetric_fir
File Edit Run Settings Help

Find: - Q5

4.3. Annotate Model with Synthesis Result

N

1% HOL workflow advisor

Analysis -
4 g 1. Set Target b
0 ~1.1. Set Target Device and Synthesis Tool Annatate synthesis resulk back ko the Simulink model
4 |G 2. Prepare Modsl For HDL Code Generation Input Parameters

O 2.1, Check Global Settings
O ~2.2, Check aAlgebraic Loops

Critical path source |pre-mute

O 2.3, Check Black Compatibility Critical path number ‘1 - |
2.4, Check 5 le Ti
o ek sample fimes Show all paths Show unique paths
4 |58 3. HOL Code Generation
4 [Gg 5.1, Set Code Generation Options /| Show delay data Shiw ends anky

@ 3.1.1. Set Basic Options

o 3.1.2, Set Advanced Options Run This Task

0 3.1.5. Set Testbench Options

o ~3,2, Generate RTL Code and Testbench Result: 9 Passed
4 |z 4. FPGA Synthesis and Analysis E
@ 4.1, Creats Project ##t# Parsing the timing file
4 |z 4.2, Perform Synthesis and PiR
@ 4.2.1. Perform Logic Synthesis i Matched Source = 'sfir_five disymmetric_firudd_outl'
0 4.2.2. Perform Mapping
@ 423, Perform Place and Route # Matched Destination = 'sfir_fize d/symmetnic_firud5_outl' 3

9 4.3, Annotate Model with Synthesis Result
#5¢ Highlighting CP 1 from 'sfir fized/symmetne firfudd outl' to 'sfir fizedfsymmetnc firfudd outl' .

Action

Reeset Highlighting critical path in Simulink model

Reset Highlighting

Result:

Help Apply

3 View the annotated critical path in the model.

The critical path is colored cyan.
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Generate HDL Code Using the Command Line

* “Overview” on page 2-30

® “Creating a Folder and Local Model File” on page 2-30

e “Initializing Model Parameters with hdlsetup” on page 2-30
® “Generating a VHDL Entity from a Subsystem” on page 2-32
® “Generating VHDL Test Bench Code” on page 2-34

e “Verifying Generated Code” on page 2-36

® “Generating a Verilog Module and Test Bench” on page 2-36
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Overview

This exercise provides a step-by-step introduction to code and test bench
generation commands, their arguments, and the files created by the code
generator. The exercise assumes that you have familiarized yourself with the
example model (see “The sfir_fixed Model” on page 2-17).

Creating a Folder and Local Model File

Make a local copy of the example model and store it in a working folder, as
follows.

1 Start the MATLAB software.
2 Create a folder named sI_hdlcoder_work, for example:

mkdir C:\work\sl_hdlcoder_work

The s1_hdIcoder work folder will store a local copy of the example model
and to store folders and code generated by the coder. The location of the
folder does not matter, except that it should not be within the MATLAB
tree.

3 Make the s1_hdlcoder work folder your working folder, for example:

cd C:\work\sl_hdlcoder_work

4 To open the example model, type the following command at the MATLAB
prompt:

sfir_fixed

5 In Simulink, select File > Save As and save a local copy of the sfir_fixed
model to your working folder.

6 Leave the sfir_fixed model open and proceed to the next section.

Initializing Model Parameters with hdlsetup

Before generating code, you must configure the model. You can use the
hdlsetup command instead of configuring the model manually. The hdlsetup
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command uses the set_param function to set up models for HDL code
generation quickly and consistently.

To configure the model for HDL code generation:

1 At the MATLAB command prompt, enter:

hdlsetup('sfir_fixed"')
2 Select Save from the File menu, to save the model with its new settings.

Before continuing with code generation, consider the settings that hdlsetup
applies to the model.

hdlsetup configures the Solver options that are recommended or required by
the coder. These are

* Type: Fixed-step. (The coder currently supports variable-step solvers
under limited conditions. See hdlsetup)

® Solver: Discrete (no continuous states). Other fixed-step solvers
could be selected, but this option is usually the best one for simulating
discrete systems.

* Tasking mode: SingleTasking. The coder does not currently support
models that execute in multitasking mode.

Do not set Tasking mode to Auto.
hdlsetup also configures the model start and stop times and fixed-step size as
follows:
e Start Time: 0.0 s
e Stop Time: 10 s
¢ Fixed step size (fundamental periodic sample time) : auto
If Fixed step size is set to auto the step size is chosen automatically, based
on the sample times specified in the model. In the example model, only the

Signal From Workspace block specifies an explicit sample time (1 s); the other
blocks inherit this sample time.
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The model start and stop times determine the total simulation time. This

in turn determines the size of data arrays that are generated to provide
stimulus and output data for generated test benches. For the example model,
computation of 10 seconds of test data does not take a significant amount of
time. Computation of sample values for more complex models can be time
consuming. In such cases, you may want to decrease the total simulation time.

The remaining parameters set by hdlsetup control error severity levels, data
logging, and model display options. If you want to view the complete set of
model parameters affected by hdlsetup, open hdlsetup.min the MATLAB
Editor.

The model parameter settings provided by are intended as useful defaults,
but they may not be optimal for your application. For example, hdlsetup sets
a default Simulation stop time of 10 s. A total simulation time of 1000 s
would be more realistic for a test of the sfir_fixed example model. If you
would like to change the simulation time, enter the desired value into the
Simulation stop time field of the Simulink window.

See the “Model Parameters” table in the “Model and Block Parameters”
section of the Simulink documentation for a summary of model parameters.

Generating a VHDL Entity from a Subsystem

In this section, you will use the makehdl function to generate code for a VHDL
entity from the symmetric_fir subsystem of the example model. makehdl
also generates script files for third-party HDL simulation and synthesis tools.

makehdl lets you specify numerous properties that control various features
of the generated code. In this example, you will use the makehdl property
defaults.

Before generating code, make sure that you have completed the steps
described in “Creating a Folder and Local Model File” on page 2-30 and
“Initializing Model Parameters with hdlsetup” on page 2-30.

To generate code:
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1 Select Current Folder from the Desktop menu in the MATLAB window.
This displays the MATLAB Current Folder browser, which lets you easily
access your working folder and the files that will be generated within it.

2 At the MATLAB prompt, type the command

makehdl('sfir_fixed/symmetric_fir')

This command directs the coder to generate code from the symmetric_fir
subsystem within the sfir_fixed model, using default property values.

3 As code generation proceeds, the coder displays progress messages. The
process should complete with the message

### HDL Code Generation Complete.

Observe that the names of generated files in the progress messages
are hyperlinked. After code generation completes, you can click these
hyperlinks to view the files in the MATLAB Editor.

makehdl compiles the model before generating code. Depending on model
display options (such as port data types, etc.), the appearance of the model
may change after code generation.

4 By default, makehdl generates VHDL code. Code files and scripts are
written to a target folder. The default target folder is a subfolder of your
working folder, named hdlsrc.

A folder icon for the hdlsrc folder is now visible in the Current Folder
browser. To view generated code and script files, double-click the hdlsrc
folder icon.

5 The files that makehdl has generated in the hd1lsrc folder are

e symmetric_fir.vhd: VHDL code. This file contains an entity definition
and RTL architecture implementing the symmetric_fir filter.

e symmetric_fir_compile.do: Mentor Graphics ModelSim compilation
script (vcom command) to compile the generated VHDL code.

e symmetric_fir_synplify.tcl: Synplify® synthesis script
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e symmetric_fir_map.txt: Mapping file. This report file maps generated
entities (or modules) to the subsystems that generated them (see “Trace
Code Using the Mapping File”).

6 To view the generated VHDL code in the MATLAB Editor, double-click the
symmetric_fir.vhd file icon in the Current Folder browser.

7 Before proceeding to the next section, close files you have opened in the
editor. Then, click the Go Up One Level button in the Current Folder
browser, to set the current folder back to your s1_hdlcoder work folder.

8 Leave the sfir_fixed model open and proceed to the next section.

Generating VHDL Test Bench Code

In this section, you use the test bench generation function, makehdltb, to
generate a VHDL test bench. The test bench is designed to drive and verify
the operation of the symmetric_fir entity that was generated in the previous
section. A generated test bench includes

¢ Stimulus data generated by signal sources connected to the entity under
test.

¢ Qutput data generated by the entity under test. During a test bench run,
this data is compared to the outputs of the VHDL model, for verification
purposes.

¢ (Clock, reset, and clock enable inputs to drive the entity under test.
® A component instantiation of the entity under test.
¢ Code to drive the entity under test and compare its outputs to the expected

data.

In addition, makehdltb generates Mentor Graphics ModelSim scripts to
compile and execute the test bench.

This exercise assumes that your working folder is the same as that used in
the previous section. This folder now contains an hd1lsrc folder containing the

previously generated code.

To generate a test bench:
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1 At the MATLAB prompt, type the command

makehdltb('sfir_fixed/symmetric_fir')

This command generates a test bench that is designed to interface to and
validate code generated from symmetric_fir (or from a subsystem with a
functionally identical interface). By default, VHDL test bench code, as well
as scripts, are generated in the hdlsrc target folder.

2 As test bench generation proceeds, the coder displays progress messages.
The process should complete with the message

### HDL TestBench Generation Complete.

3 To view generated test bench and script files, double-click the hdlsrc
folder icon in the Current Folder browser. Alternatively, you can click the
hyperlinked names of generated files in the code test bench generation
progress messages.

The files generated by makehdltb are:

e symmetric_fir_ tb.vhd: VHDL test bench code and generated test and
output data.

e symmetric_fir_ tb compile.do: Mentor Graphics ModelSim
compilation script (vcom commands). This script compiles and loads both
the entity to be tested (symmetric_fir.vhd) and the test bench code
(symmetric_fir_ tb.vhd).

e symmetric_fir_ tb_sim.do: Mentor Graphics ModelSim script to
Initialize the simulator, set up wave window signal displays, and run a
simulation.

4 If you want to view the generated test bench code in the MATLAB Editor,
double-click the symmetric_fir.vhd file icon in the Current Folder
browser. You may want to study the code while referring to the makehdltb
reference documentation, which describes the default actions of the test
bench generator.

5 Before proceeding to the next section, close files you have opened in the
editor. Then, click the Go Up One Level button in the Current Folder
browser, to set the current folder back to your s1_hdlcoder_work folder.
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Verifying Generated Code

You can now take the previously generated code and test bench to an HDL
simulator for simulated execution and verification of results. See “Simulating
and Verifying Generated HDL Code” on page 2-49 for an example of how to
use generated test bench and script files with the Mentor Graphics ModelSim
simulator.

Generating a Verilog Module and Test Bench

The procedures for generating Verilog code differ only slightly from those for
generating VHDL code. This section provides an overview of the command
syntax and the generated files.

Generating a Verilog Module. By default, makehdl generates VHDL
code. To override the default and generate Verilog code, you must pass in
a property/value pair to makehdl, setting the TargetLanguage property to
'verilog', as in this example.

makehdl('sfir_fixed/symmetric_fir', 'TargetlLanguage', 'verilog')

The previous command generates Verilog source code, as well as scripts for
the simulation and the synthesis tools, in the default target folder, hdlsrc.

The generated files are:

e symmetric_fir.v: Verilog code. This file contains a Verilog module
implementing the symmetric_fir subsystem.

e symmetric_fir compile.do: Mentor Graphics ModelSim compilation
script (vlog command) to compile the generated Verilog code.

e symmetric_fir_ synplify.tcl: Synplify synthesis script.

® symmetric_fir_map.txt: Mapping file. This report file maps generated
entities (or modules) to the subsystems that generated them (see “Trace
Code Using the Mapping File”).

Generating and Executing a Verilog Test Bench. The makehdltb syntax
for overriding the target language 1s exactly the same as that for makehdl.
The following example generates Verilog test bench code to drive the Verilog
module, symmetric_fir, in the default target folder.
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makehdltb('sfir_fixed/symmetric_fir', 'TargetlLanguage', 'verilog')
The generated files are:

e symmetric_fir_tb.v: Verilog test bench code and generated test and
output data.

e symmetric_fir_tb_compile.do: Mentor Graphics ModelSim compilation
script (vlog commands). This script compiles and loads both the entity to be
tested (symmetric_fir.v) and the test bench code (symmetric_fir_ tb.v).

e symmetric_fir_tb_sim.do: Mentor Graphics ModelSim script to initialize
the simulator, set up wave window signal displays, and run a simulation.

The following listing shows the commands and responses from a test bench
session using the generated scripts:

ModelSim> do symmetric_fir_tb_compile.do
Model Technology ModelSim SE vlog 6.0 Compiler 2004.08 Aug 19 2004

- Compiling module symmetric_fir

Top level modules:
symmetric_fir
Model Technology ModelSim SE vlog 6.0 Compiler 2004.08 Aug 19 2004

- Compiling module symmetric_fir_tb

#
#
#
#
#
#
#
#
# Top level modules:
# symmetric_fir_tb
ModelSim>do symmetric_fir_tb_sim.do
vsim work.symmetric_fir_tb
Loading work.symmetric_fir_tb
Loading work.symmetric_fir

***x* Test Complete. ****
:/work/sl_hdlcoder_work/vlog_code/symmetric_fir_tb.v line 142

Simulation Breakpoint:Break at

#
#
#
#
# Break at
C
#
C:/work/sl_hdlcoder_work/vlog_code/symmetric_fir_tb.v line 142
#

MACRO ./symmetric_fir_tb_sim.do PAUSED at line 14
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Generate HDL Code Using the Configuration
Parameters Dialog Box

¢ “HDL Coder GUI Overview” on page 2-38
¢ “Creating a Folder and Local Model File” on page 2-40

* “Viewing Coder Options in the Configuration Parameters Dialog Box” on
page 2-41

e “Initializing Model Parameters with hdlsetup” on page 2-42

o “Selecting and Checking a Subsystem for HDL Compatibility” on page 2-44
® “Generating VHDL Code” on page 2-45

¢ “Generating VHDL Test Bench Code” on page 2-47

* “Verifying Generated Code” on page 2-49

® “Generating Verilog Model and Test Bench Code” on page 2-49

HDL Coder GUI Overview

You can view and edit options and parameters that affect HDL code generation
in the Configuration Parameters dialog box, or in the Model Explorer.

The following figure shows the top-level HDL Code Generation pane in the
Configuration Parameters dialog box.
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The following figure shows the top-level HDL Code Generation options
pane in the Model Explorer.
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In the code generation exercises that follow, you use the Configuration
Parameters dialog box to view and set the coder options and controls. The
exercises use the sfir_fixed model (see “The sfir_fixed Model” on page 2-17)
in basic code generation and verification steps.

Creating a Folder and Local Model File
In this section you will setup the folder and a local copy of the example model.

Creating a Folder. Start by setting up a working folder:

2 Create a folder named sI_hdlcoder_work, for example:

Start MATLAB.

mkdir C:\work\sl_hdlcoder_work
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You will use s1_hdIlcoder _work to store a local copy of the example model
and to store folders and code generated by the coder. The location of the

folder does not matter, except that it should not be within the MATLAB
folder tree.

3 Make the sI_hdlcoder_work folder your working folder, for example:

cd C:\work\sl_hdlcoder_work

Making a Local Copy of the Model File. Next, make a copy of the
sfir_fixed model:

1 To open the model, type the following command at the MATLAB prompt:
sfir_fixed
2 Save a local copy of the sfir_fixed model to your working folder.

3 Leave the sfir_fixed model open and proceed to the next section.

Viewing Coder Options in the Configuration Parameters
Dialog Box

The coder option settings are displayed as a category of the model’s active
configuration set. You can view and edit these options in the Configuration
Parameters dialog box, or in the Model Explorer. This discussion uses the
Configuration Parameters dialog box.

To access the coder settings:

1 Open the Configuration Parameters dialog box.

2 Select the HDL Code Generation pane.
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The HDL Code Generation pane contains top-level options and buttons
that control the HDL code generation process. Several other categories of
options are available under the HDL Code entry. This exercise uses a

small subset of these options, leaving the others at their default settings.

Initializing Model Parameters with hdlsetup

Before generating code, you must set some parameters of the model. Rather
than doing this manually, use the hdlsetup command. The hdlsetup
command uses the set_param function to set up models for HDL code
generation quickly and consistently.
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To set the model parameters:

1 At the MATLAB command prompt, type:

hdlsetup('sfir_fixed"')
2 Save the model with its new settings.

Before continuing with code generation, consider the settings that hdlsetup
applies to the model.

hdlsetup configures Solver options that are recommended or required by
the coder. These options are:

® Type: Fixed-step. (The coder currently supports variable-step solvers
under limited conditions. See hdlsetup.)

® Solver: Discrete (no continuous states). Other fixed-step solvers
could be selected, but this option is usually the best one for simulating
discrete systems.

¢ Tasking mode: SingleTasking. The coder does not currently support
models that execute in multitasking mode.

Do not set Tasking mode to Auto.
hdlsetup also configures the model start and stop times and fixed-step size as
follows:
e Start Time: 0.0 s
® Stop Time: 10 s
¢ Fixed step size (fundamental periodic sample time): auto
If Fixed step size is set to auto the step size is chosen automatically, based
on the sample times specified in the model. In the example model, only the

Signal From Workspace block specifies an explicit sample time (1 s); the other
blocks inherit this sample time.

The model start and stop times determine the total simulation time. This

in turn determines the size of data arrays that are generated to provide
stimulus and output data for generated test benches. For the example model,
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computation of 10 seconds of test data does not take a significant amount of
time. Computation of sample values for more complex models can be time
consuming. In such cases, you may want to decrease the total simulation time.

The remaining parameters set by hdlsetup control error severity levels, data
logging, and model display options. If you want to view the complete set of
model parameters affected by hdlsetup, open hdlsetup.min the MATLAB
Editor.

The model parameter settings provided by hdlsetup are intended as useful
defaults, but they may not be optimal for your application. For example,
hdlsetup sets a default Simulation stop time of 10 s. A total simulation
time of 1000 s would be more realistic for a test of the sfir_fixed example
model. If you would like to change the simulation time, enter the desired
value into the Simulation stop time field of the Simulink Editor.

See the “Model Parameters” table in the “Model and Block Parameters”
section of the Simulink documentation for a summary of model parameters.

Selecting and Checking a Subsystem for HDL Compatibility

The coder generates code from either the current model or from a subsystem at
the root level of the current model. You use the Generate HDL for menu to
select the model or subsystem from which code is to be generated. Each entry
in the menu shows the full path to the model or one of its subcomponents.

The sfir_fixed model is configured with the sfir_fixed/symmetric_fir
subsystem selected for code generation. If this is not the case, make sure that
the symmetric_fir subsystem is selected for code generation, as follows:

1 Select sfir_fixed/symmetric_fir from the Generate HDL for menu.

2 Click Apply.

To check HDL compatibility for the subsystem:

1 Click the Run Compatibility Checker button.

2 The HDL compatibility checker examines the system selected in the
Generate HDL for menu for compatibility problems. In this case, the
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selected subsystem is fully HDL-compatible, and the compatibility checker
displays the following message:

### Starting HDL Check.
### HDL Check Complete with O errors, warnings and messages.

The compatibility checker also displays a report in a new window.

Generating VHDL Code

The top-level HDL Code Generation options are now set as follows:

¢ The Generate HDL for field specifies the sfir_fixed/symmetric_fir
subsystem for code generation.

¢ The Language field specifies (by default) generation of VHDL code.

¢ The Folder field specifies a target folder that stores generated code files
and scripts. The default target folder is a subfolder of your working folder,
named hdlsrc.
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Before generating code, select Current Folder from the Desktop menu in
the MATLAB window. This displays the Current Folder browser, which lets
you access your working folder and the files that will be generated within it.

To generate code:

1 Click the Generate button.

2 As code generation proceeds, the coder displays progress messages. The
process should complete with the message
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### HDL Code Generation Complete.

Observe that the names of generated files in the progress messages
are hyperlinked. After code generation completes, you can click these
hyperlinks to view the files in the MATLAB Editor.

The coder compiles the model before generating code. Depending on model
display options (such as port data types, etc.), the appearance of the model
may change after code generation.

3 A folder icon for the hdlsrc folder is now visible in the Current Folder
browser. To view generated code and script files, double-click the hdlsrc
folder icon.

4 The files that were generated in the hdlsrc folder are:

o symmetric_fir.vhd: VHDL code. This file contains an entity definition
and RTL architecture implementing the symmetric_fir filter.

e symmetric_fir_compile.do: Mentor Graphics ModelSim compilation
script (vcom command) to compile the generated VHDL code.

e symmetric_fir_synplify.tcl: Synplify synthesis script.

e symmetric_fir_map.txt: Mapping file. This report file maps generated
entities (or modules) to the subsystems that generated them (see “Trace
Code Using the Mapping File”).

5 To view the generated VHDL code in the MATLAB Editor, double-click the
symmetric_fir.vhd file icon in the Current Folder browser.

6 Before proceeding to the next section, close files you have opened in the
editor. Then, click the Go Up One Level button in the Current Folder
browser, to set the current folder back to your s1_hdlcoder work folder.

Generating VHDL Test Bench Code

At this point, the Generate HDL for, Language, and Folder fields are

set as they were in the previous section. Accordingly, you can now generate
VHDL test bench code to drive the VHDL code generated previously for the
sfir_fixed/symmetric_fir subsystem. The code will be written to the same
target folder as before.
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To generate a VHDL test bench:

1 Select the HDL Code Generation > Test Bench pane.
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2 Select HDL test bench.

3 Click the Generate Test Bench button.

The process should complete with the message

4 As test bench generation proceeds, the coder displays progress messages.
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### HDL TestBench Generation Complete.

5 The generated files in the hdlsrc folder are:

e symmetric_fir_tb.vhd: VHDL test bench code, with generated test
and output data.

e symmetric_fir_tb_compile.do: Mentor Graphics ModelSim
compilation script (vcom commands). This script compiles and loads
the entity to be tested (symmetric_fir.vhd) and the test bench code
(symmetric_fir_tb.vhd).

e symmetric_fir_tb_sim.do: Mentor Graphics ModelSim script to
initialize the simulator, set up wave window signal displays, and run a
simulation.

Verifying Generated Code

You can now take the generated code and test bench to an HDL simulator for
simulated execution and verification of results. See “Simulating and Verifying
Generated HDL Code” on page 2-49 for an example of how to use generated
test bench and script files with the Mentor Graphics ModelSim simulator.

Generating Verilog Model and Test Bench Code

The procedure for generating Verilog code is the same as for generating VHDL
code (see “Generating a VHDL Entity from a Subsystem” on page 2-32 and
“Generating VHDL Test Bench Code” on page 2-34), except that you select
Verilog from the Language field of the HDL Code Generation options.

Simulating and Verifying Generated HDL Code

Note This section requires the use of the Mentor Graphics ModelSim
simulator.

This section assumes that you have generated code from the sfir_fixed
model as described in either of the following exercises:

¢ “Generate HDL Code Using the Command Line” on page 2-29
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® “Generate HDL Code Using the Configuration Parameters Dialog Box”
on page 2-38

In this section you compile and run a simulation of the previous generated
model and test bench code. The scripts generated by the coder let you do this
with just a few simple commands. The procedure is the same, whether you
generated code in the command line environment or in the GUI.

To run the simulation:

1 Start the Mentor Graphics ModelSim software.
2 Set the working folder to the folder in which you previously generated code.

ModelSim>cd C:/work/sl_hdlcoder_work/hdlsrc

3 Use the generated compilation script to compile and load the generated
model and text bench code. The following listing shows the command
and responses.

ModelSim>do symmetric_fir_tb_compile.do

# Model Technology ModelSim SE vcom 6.0 Compiler 2004.08 Aug 19 2004
# -- Loading package standard

- Loading package std_logic_1164

- Loading package numeric_std

- Compiling entity symmetric_fir

- Compiling architecture rtl of symmetric_fir

Model Technology ModelSim SE vcom 6.0 Compiler 2004.08 Aug 19 2004
- Loading package standard

- Loading package std_logic_1164

- Loading package numeric_std

- Compiling package symmetric_fir_tb_pkg

- Compiling package body symmetric_fir_tb_pkg

- Loading package symmetric_fir_tb_pkg

- Loading package symmetric_fir_tb_pkg

- Compiling entity symmetric_fir_tb

- Compiling architecture rtl of symmetric_fir_tb

EEE T T R R I I

- Loading entity symmetric_fir
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4 Use the generated simulation script to execute the simulation. The
following listing shows the command and responses. The warning messages
are benign.

ModelSim>do symmetric_fir_tb_sim.do

# vsim work.symmetric_fir_tb

# Loading C:\Applications\ModelTech_6_0\win32/../std.standard

# Loading C:\Applications\ModelTech_6_0\win32/../ieee.std_logic_1164(body)
Loading C:\Applications\ModelTech_6_0\win32/../ieee.numeric_std(body)
Loading work.symmetric_fir_tb_pkg(body)

Loading work.symmetric_fir_tb(rtl)

Loading work.symmetric_fir(rtl)

** Warning: NUMERIC_STD."<": metavalue detected, returning FALSE

B

Time: 0 ns Iteration: O Instance: /symmetric_fir_tb

** Warning: NUMERIC_STD.TO_INTEGER: metavalue detected, returning O
Time: 0 ns Iteration: 1 1Instance: /symmetric_fir_tb
*% Note: *****x*xxkkx**x*TEQT COMPLETED ********xkxkkx

H* O W

Time: 140 ns Iteration: 1 Instance: /symmetric_fir_tb

The test bench termination message indicates that the simulation has run
to completion without comparison errors.

* % r kkkkkkkkkhkkhkkhkkkk kkhkkkkkkkkhkkhkkkk*x
# Note: TEST COMPLETED

5 The simulation script displays inputs and outputs in the model (including
the reference signals y_out_ref and delayed x_out_ref) in the Mentor
Graphics ModelSim wave window. The following figure shows the signals
displayed in the wave window.
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6 Exit the Mentor Graphics ModelSim simulator when you finish viewing

signals.
7 Close files you have opened in the MATLAB Editor. Then, click the Go

Up One Level button in the Current Folder browser, to set the current

folder back to your work folder.
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